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Введение 
 

Цели изучения дисциплины «Основы гипертекстового представления 

Интернет-контента» состоят в формировании знаний и практических навыков 

использования современных языков разметки, разработки веб-интерфейстов и 

тестирования веб-приложений, функционирующих в сети Интернет. 

В качестве клиентского приложения мы будем использовать браузер, ус- 

тановленныи ̆ в нашеи ̆ операционнои ̆ системе. Выполняя лабораторные работы, 

мы не будем использовать каких-либо специфических элементов разметки или 

стилеи ̆, поэтому ограничении ̆ к браузеру предъявляться не будет. 

 

В качестве текстового редактора будем использовать программу «Notepad++». 

Скачать последнюю версию и прочитать ее ̈ описание можно на саи ̆- те 

http://notepad-plus-plus.org/. Можно использовать аналогичную программу.Если 

в процессе выполнения лабораторных работ понадобятся другие программные 

продукты, то об этом будет сказано. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

Лабораторная работа №1: Создание простейшей HTML-страницы с 

подключением CSS и JS-скриптов 

 Создадим простейшую HTML-страницу с помощью текстового и 

графического редакторов. 

  
Самый простой текстовый редактор, подходящий для верстки - это 

NotePad++. Помимо этого существуют профессиональные редакторы с 

возможностью подключения плагинов, которые упрощают работу. К ним 

относятся Sublime Text 3, Atom.  

Браузерный движок - это платформа, переносящая информацию о 

разметке и форматировании страницы в интерактивное изображение на экране. 

Применяется в основном в программах, требующих отображение и 

редактирование содержимого веб-страниц.  

Редакторы изображений 

Макеты для верстки в основном представляются в форматах .PSD (Adobe 

Photoshop, Gimp), .AI (Adobe Illustrator), .SKETCH (Sketch). К сожалению, 

Sketch доступен только для пользователей OS X, но существуют сторонние 

программы, например Avocode. Помимо файлов Sketch он позволяет также 

конвертировать и файлы Photoshop. Условно бесплатная, пробная версия 14 

дней. 

 

Простейшая страница может выглядеть так: 

<!DOCTYPE html> 

<html> 

<head> 

<title>Заголовок страницы.</title> 

</head> 

<body> 

 

<h1>Мой первый заголовок.</h1> 

<p>Мой первый абзац.</p> 

 



 

 

</body> 

</html> 

 

Разметка начинается с описания типа документа в теге <!DOCTYPE>, для 

последующего корректного отображения страницы. Это необходимо, чтобы 

браузер понимал, как следует интерпретировать текущую веб-страницу, 

поскольку HTML существует в нескольких версиях, кроме того, имеется 

XHTML (EXtensible HyperText Markup Language, расширенный язык разметки 

гипертекста), похожий на HTML, но различающийся с ним по синтаксису.  

Далее располагается тег <html></html>, в нем будет описываться текущий 

документ. Также в нем можно указать язык текущей страницы (ru - для 

русского, en - для английского). Это предназначено для многоязычных сайтов, а 

также 

 В теге <head></head> размещается информация, предназначенная для 

браузеров и поисковых систем: в нем подключаются стили, скрипты, 

устанавливается кодировка, описываются ключевые слова и фразы, задается 

заголовок страницы. Информация, заключенная в теге <head> никак не 

отображается на странице (за исключением тега <title></title>, в котором 

пишется заголовок страницы, отображаемый в верхней панели браузера и 

вкладке). 

Тег <body></body> - основной, только его содержимое будет 

отображаться на странице. В нем описывается контент. В примере выше внутри 

тега <body></body> лежат тег заголовка первого уровня (<h1></h1>) и абзаца 

(<p></p>).  

Браузер не отображает сами теги, но использует их как инструкцию того, 

как отображать документ. 

 Для подключения скриптов используется тег <script>, причем неважно 

пишите ли вы скрипты в html-документе, или же выносите их в отдельный 

файл. В первом случае текст скрипта записывается просто между 

открывающим и закрывающим тегом. Если же скрипты необходимо 

подключить внешний документ, то она записывается в атрибуте src=””. Помимо 

атрибута src также существуют: 

● async -  загружает скрипт асинхронно; 

● defer - Откладывает выполнение скрипта до тех пор, пока вся 

страница не будет загружена полностью; 



 

 

● language - Устанавливает язык программирования на котором 

написан скрипт. Этот атрибут является необязательным, т.к. в 

стандарте html 5 он принимает по умолчанию значение 

text/javascript, если не указан явно;  

● src - Адрес скрипта из внешнего файла для импорта в текущий 

документ; 

● type - Определяет тип содержимого <script>. 

 В отличие от тега <link> и <style>, <script> можно указывать как в теге 

<head>, так и в <body>.  

 

Лабораторная работа №2: Photoshop для верстки веб-страниц. 

Информация о слоях 

Убедитесь, что Photoshop правильно настроен: выпадающее меню Edit → 

Color Settings (вызывается Shift + Ctrl + K), выставьте для RGB вариант 

sRGB. Это то цветовое пространство, в котором “работает” весь веб. 

Дополнительная настройка: Edit → Preferences → Units & Rulers (для OS 

X пункт Preferences — в выпадающем меню с названием программы), в 

выпадающих списках для «Rulers» и «Type» нужно выбрать единицы 

измерения «Pixels». 

Интерфейс 

 



 

 

Под выпадающим меню длинная горизонтальная область — в ней 

отображаются настройки активного инструмента. 

Панель со всеми инструментами слева, прочие панели справа или 

«плавают». 

Внешний вид Photoshop настраивается: можно перетаскивать панели, 

включать и отключать их видимость (в выпадающем меню Window), 

сворачивать и разворачивать (двойной клик по названию панели), сворачивать в 

иконки. 

Создав рабочее окружение с нужными панелями и скрыв всё ненужное, 

можно сохранить вариант получившегося интерфейса. Список рабочих 

окружений — в верхней правой части окна, в нижней части списка есть пункт 

«New Workspace...» — нажимаем, именуем, сохраняем. 

Необходимые и желательные для верстальщика панели: 

1. Layers — панель слоёв — папки и слои макета. 

2. Character — данные о выделенном текстовом слое или тексте (шрифт, 

цвет, размер, интерлиньяж и другое). 

Прочие панели — по вкусу верстальщика, у каждого свои методы работы 

с макетом. 

Как верстальщику работать в фотошопе 

Если вы правша, держите левую руку на левой части клавиатуры, чтобы 

легко доставать до Shift, Ctrl, Alt и Пробел. 

Включите линейки (выпадающее меню View → Rules, поставить галочку 

(оно же — Ctrl+ R)), убедитесь, что они показывают пиксели (правой кнопкой 

мыши кликнуть на линейке, выбрать пиксели). 

Ориентация по документу 

Tab — показать или скрыть все панели. 



 

 

Зажать Пробел, «схватить» мышью за документ и перетаскивать — 

перемещение в рамках масштаба. Зажатие кнопки временно активирует 

инструмент Hand Tool. 

Ctrl + 0 — вписать макет в рабочую область. 

Ctrl + 1 — установка масштаба 100%. 

Зажать H, зажать левую кнопку мыши — документ масштабируется так, 

чтоб был виден целиком, можно перетащить рамку (вы держите левую кнопку 

нажатой, просто тащите мышь) в любое место и отпустить — окажитесь в этой 

области с тем масштабом, который был ранее.  

Зажать Alt, крутить колесо мыши — масштабирование в обе стороны 

вокруг того места, где расположен курсор. 

Выбор слоёв 

Зажать Ctrl и кликнуть на слой. Зажатие кнопки временно активирует 

инструмент Move Tool. Работает в случае выбора любого инструмента кроме 

Hand Tool (по зажатиюCtrl включается инструмент масштабирования) и самого 

Move Tool. Чтобы это работало, убедитесь, что настройки инструмента Move 

Tool (это панель под выпадающими меню, когда инструмент выбран) 

выставлены следующие: Auto-Select — галка стоит, в выпадающем списке 

рядом — Layer. 

Показать и скрыть 

Показать или скрыть какие-либо слои просто — кликнуть на иконке 

«глаз» этого слоя в панели слоёв (или с клавиатуры: Ctrl + ,). 

Alt + клик по иконке «глаз» в панели слоёв — показать только один этот 

слой, прочее скрыть, повторный клик, чтобы вернуть статус кво. 

Информация о слоях 

Двойной клик по миниатюре текстового слоя — редактирование слоя, 

выставляйте текстовой курсор в нужное место — узнаёте шрифт, размер, 

интерлиньяж, трансформации, кернинг, спейсинг и цвет. Если параметры 

Horizontally Scale или Vertically Scale отличаются от 100%, нужно 



 

 

экспериментировать с CSS3-свойством transform у блока, в который включать 

только этот текст и налаживать взаимодействие дизайнера и верстальщика, 

если это контентный текст. 

Двойной клик по миниатюре слоя с цветом, градиентом, заливкой 

текстурой — вызов модального окна с данными слоя. 

Если у слоя справа есть курсивная надпись «fx» (и иконка, открывающая 

список), значит у него есть эффекты. Кликайте на открывающую иконку — 

увидите список эффектов (можно отключить их показ — кликаем на иконки 

глаза рядом с эффектами), двойной клик по эффекту вызовет панель с 

настройками эффекта. 

Цвет в макете: инструмент Euedropper Tool (в настройках указать Sample 

Size → Point Sample). Кликаем по произвольному пикселю, в панели цвета (под 

всеми инструментами) видим цвет пикселя. 

Размер в макете: инструмент Ruler Tool — нажать, тащить мышью, 

отпустить — в панели настроек (под выпадающм меню, параметр L1) увидите 

измеренное расстояние. Если тащить с зажатым Shift, измеритель 

перемещается строго горизонтально, строго вертикально или под 45° (для 

верстальщика не актуально). 

Можно использовать Rectangle Marquee Tool, создавая выделение (размер 

выделения будет показан рядом с выделением), если фотошоп версии CS6 и 

новее. Убрать получившееся после измерения выделение — Ctrl + D. 

Показать и скрыть сетку, направляющие, габариты трансформации, 

нарезку — Ctrl +H. 

Отмена и повтор последнего действия — Ctrl + Z (снова спасибо, Кэп!) 

Отмена действий последовательно — Ctrl + Alt + Z 

Команда из выпадающего списка Image → Trim — подрезка прозрачных 

или однотонных пикселей (удобно, если нужно получить слой на прозрачном 

фоне: копируем слой в новый документ, подрезаем, экспортируем). 

 



 

 

Лабораторная работа №3: Основные приемы построения модульных сеток. 

Поток — это порядок отображения элементов на странице. По 

умолчанию блочные элементы отображаются как прямоугольные области, 

идущие друг за другом сверху вниз, а строчные элементы располагаются сверху 

вниз и слева направо и при необходимости переносятся на новую строку. 

Один и тот же HTML-код можно выстроить в разные потоки. Например, 

вот так: 

 

Существует несколько способов управлять потоком и строить сетки: 

1. float; 

2. inline-block; 

3. табличная вёрстка; 

4. flexbox. 

Табличная вёрстка — самый простой для понимания способ построения 

сеток. Но он считается устаревшим и использовать его не рекомендуется. 

Флексбоксы — это новая и очень мощная технология для построения 

сеток. К сожалению, её поддержка браузерами ещё достаточно слабая. 

Флоаты и инлайн-блоки наиболее распространенные и поддерживаемые 

способы создания сеток.  

  

Лабораторная работа №4: Cоздание декоративных элементов веб-страниц 

Создадим простую кнопку, используя псевдо-классы и псевдо-элементы. 



 

 

 

Стили для класса button, которые создают круг с красным градиентом: 

.button { 

 height: 100px; 

 width: 100px; 

 position: relative; 

 margin: 50px; 

 color: white; 

 text-align: center; 

 line-height: 100px; 

  

 /*закругленные углы и тень*/ 

 -webkit-border-radius: 100px; 

 -moz-border-radius: 100px; 

 border-radius: 100px; 

 -webkit-box-shadow: 2px 2px 4px rgba(0,0,0,0.4); 

 -moz-box-shadow: 2px 2px 4px rgba(0,0,0,0.4); 

 box-shadow: 2px 2px 4px rgba(0,0,0,0.4); 

  

 /*градиент*/ 

 background: #e51d16; /* для старых браузеров */ 

 background: -moz-linear-gradient(top,  #e51d16 0%, #b21203 100%); /* 

для FF3.6+ */ 

 background: -webkit-gradient(linear, left top, left bottom, color-

stop(0%,#e51d16), color-stop(100%,#b21203)); /* для Chrome,Safari4+ */ 



 

 

 background: -webkit-linear-gradient(top,  #e51d16 0%,#b21203 100%); /* 

для Chrome10+,Safari5.1+ */ 

 background: -o-linear-gradient(top,  #e51d16 0%,#b21203 100%); /* для 

Opera 11.10+ */ 

 background: -ms-linear-gradient(top,  #e51d16 0%,#b21203 100%); /* для 

IE10+ */ 

 background: linear-gradient(top,  #e51d16 0%,#b21203 100%); /* W3C */ 

 filter: progid:DXImageTransform.Microsoft.gradient( 

startColorstr='#e51d16', endColorstr='#b21203',GradientType=0); /* IE6-9 */ 

} 

Весь этот код приведет к созданию довольно простой, круглой кнопки: 

 

Добавим затемненную область за пределами кнопки и придать ей 

внутреннюю тень. Вместо добавления дополнительной разметки, будем 

использовать пустой псевдо-элемент. 

.button:before { 

 content:""; 

} 

Сделаем тоже самое еще раз. Это можно осуществить используя псевдо-

элемент :after и повторить процесс. 

.button:after { 



 

 

 content:""; 

} 

 

 

Лабораторная работа №5: Каскадные таблицы стилей 

Набор правил CSS состоит из селектора и блока декларации. Декларация 

представляет из себя набор пар правило-значение. 

 

 

 
 

 

Селектор указывает на HTML элемент, который нужно стилизовать.Блок 

декларации состоит из одного или нескольких значений, разделенных точкой с 

запятой. Каждая декларация включает в себя имя CSS-свойства и значение, 

разделенные двоеточием.Декларация всегда заканчивается точкой с запятой, а 

блок объявления окружен фигурными скобками. 

p { 

 color: red; 

 text-align: center; 

} 

Селекторы в CSS используются для того, чтобы найти (или выбрать) 

HTML-элементы по типу, идентификатору, классу, атрибуту или их 

комбинаций. 

Селектор типа основанные на названии тега. В примере ниже стили 

будут применены ко всем тегам <p></p>: 

p { 

 text-align: center; 

 color: red; 

} 



 

 

Селектор идентификатора использует атрибут ID для выбора 

конкретного элемента. ID элемента должен быть уникальным на странице, 

поэтому стили написанные для селектор по ID применятся к одному элементу. 

Для выбора элемента сначала пишется символ хэш (#), а затем значение 

атрибута ID.  

#para1 { 

 text-align: center; 

 color: red; 

} 

В примере выбирается HTML-элемент с id=”para1”. Название id не может 

начинаться с цифры! 

Селектор класса наиболее часто используемый селектор. С помощью 

этого селектора выбираются все элементы с определенным значением атрибута 

class. 

Выбор элементов через класс производится с помощью записи названия 

класса и точки перед ним. 

В примере ниже, все элементы с классом “center” будут красными и 

выравненны по центру. 

.center { 

 text-align: center; 

 color: red; 

} 

Вы можете также указать конкретные теги с нужным классом. В примере 

ниже свойства выбраны все <p> со значением класса = “center”: 

p.center { 

 text-align: center; 

 color: red; 

} 

HTML-элемент может быть стилизован несколькими классами. Имя 

класса не может начинаться с цифры! 

 

Группы селекторов 

Если у вас есть селекторы с одинаковыми стилями, как здесь  

h1 { 

 text-align: center; 

 color: red; 



 

 

} 

 

h2 { 

 text-align: center; 

 color: red; 

} 

 

p { 

 text-align: center; 

 color: red; 

} 

То лучше всего их сгруппировать, для минимизации кода.  

Для группировки селекторы просто записываются через запятую, как в 

примере ниже: 

h1, h2, p { 

 text-align: center; 

 color: red; 

} 

 

Вес каскада 

 

Очень часто возникает ситуация, когда к одному и тому же тегу 

применяется несколько конфликтующих друг с другом стилей. И, для того, 

чтобы это конфликты разрешить применяется свойство каскадностьи и вес. 

Если никаких стилей для тега не записано, то применится таблица стилей 

браузера, в которой определены свойства для всех тегов. Если же стили 

записаны, и они имеют равный вес, то применяется то правило, которое 

записано ниже по коду.  

Как же рассчитывается вес селектора? 

Представим восемь колонок: 0-0-0-0-0-0-0-0 

Селектор типа имеет самый низкий вес, поэтому за каждый тег в записи 

можно прибавить в самый правый столбец единицу: 

div a - 0-0-0-0-0-0-0-2 

div   -  0-0-0-0-0-0-0-1 

Каждый класс (и псевдокласс) добавляет единицу во второй справа 

столбец. Сюда же добавлет единицу и селектор атрибутов: 



 

 

.head .logo –  0-0-0-0-0-0-2-0 

.logo.big  –    0-0-0-0-0-0-2-0 

div:first-child – 0-0-0-0-0-0-1-1 

.logog > .big -  0-0-0-0-0-0-2-0 

 

Каждый ID +1 в третий справа: 

#header - 0-0-0-0-0-1-0-0 

#header nav 0-0-0-0-0-1-1-0 

Лабораторная работа №6: Введение в Java-script 

Создадим простейший скрипт плавного перемещения текста слева 

направо. 

Сначала следует ввести текст в тэге <div>, ограничивающем текст, 

добавить идентификатор id.  

<html>  

<head> 

<title>Простая страница</title> </head> 

<body> 

<div id="anim"> 

Текст, шагом марш! 

</div>  
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</body> 
</html> 
 

Затем воспользуемся CSS, чтобы поместить текст в начальное 
положение:  

<html> <head>  

<title>Простая страница</title> 
</head> 
<body> 
<div id="anim" style="position:absolute; left:10; top:10"> Текст, шагом марш!  

</div> 
</body> 
</html> 
 



 

 

Далее начинаем работать над сценарием JavaScript. Поскольку не нужно, 

чтобы текст вечно двигался вправо, надо предусмотреть возможность 

контролирования этого процесса. Чтобы запустить сценарии ̆ на выполнение 

только при условии, если текст находится, например, менее чем в 500 пикселах 

от левои ̆ границы экрана, удобнее всего воспользоваться оператором if. Для 

этого понадобится атрибут CSS pixelLeft.  

<html> 
<head> 
<title>Простая страница</title> 
<script language="JavaScript"> 
function moveTxt() 
{ 
if (anim.style.pixelLeft < 500) 
{ 
} 
} 
</script> 
</head> 
<body> 
<div id="anil" style="position:absolute; left:10; top:10"> 
Текст, шагом марш! 
</div> 
</body> 
</html> 
 

Теперь рассмотрим операторы, управляющие анимациеи ̆. Прежде  всего 

нужно задать скачок. Каждыи ̆ раз текст будет перемещаться вправо на 50 

пикселеи ̆. Атрибут pixelLeft используется не только для определения 

положения текста, но и для изменения положения на 50 пикселеи ̆:  

<html> 
<head> 
<title>Простая страница</title> 
<script language="JavaScript"> 
function moveTxt() 
{ 
if (anim.style.pixelLeft < 500) 
{ 



 

 

anim.style.pixelLeft +=50; 
} 
} 
</script> 
</head> 
<body> 
<div id="anim" style="position:absolute; left:10; top:10"> 
Текст, шагом марш! 
</div> 
</body> 

Далее речь пойдет об интервале. Он задается с помощью метода 

setTimeout, позволяющего вновь запустить функцию после истечения 

определенного промежутка времени. Давайте установим интервал до 

повторного запуска функции moveTxt(), равным 5000 мс:  

<html> 
<head> 
<title>Простая страница</title> 
<script language="JavaScript"> 
<!-- Маскируемся! 
function moveTxt() 
{ 
if (anim.style.pixelLeft < 500) 
{ 
anim.style.pixelLeft +=50; 
setTimeout("moveTxt()", 5000); 
} 
} 
</script> 
</head> 
<body> 
<div id="anim" style="position:absolute; left:10; top:10"> Текст, шагом марш! 
</div> 
</body> 
</html>  

Процесс будет повторяться до тех пор, пока условие оператора if не 

станет ложным. Последнее, что нужно сделать, - запустить сценарии ̆ на 

выполнение. Для этого следует воспользоваться событием onLoad:  



 

 

<html> 
<head> 
<title>Простая страница</title> 
<script language="JavaScript"> 
function moveTxt() 
{ 
if (anil.style.pixelLeft < 500) 
{ 
anil.style.pixelLeft +=2; 
setTimeout("moveTxt()", 50); 
} 
} 
</script> 
</head> 
<body onLoad="moveTxt()"> 
<div id="anil" style="position:absolute; left:10; top:10"> Текст, шагом марш! 
</div> 
</body> 
</html>  

 

Лабораторная работа №7: Основы анимации на CSS 
Создадим кнопку загрузки с анимацией подпрыгивания. 

Чтобы определить анимацию, просто напишите ключевое слово 

@keyframes с его названием: 

@keyframes around { 

  0%  { left: 0; top: 0; } 

  25% { left: 240px; top: 0; } 

  100% { left: 0; top: 0; } 

} 

p { animation: around 4s linear infinite; } 

Обратите внимание, что начало 0% и конец 100% содержат одинаковые 

правила CSS. Это гарантирует, что анимация зациклится идеально. Поскольку 

счётчик итераций установлен как infinite, то анимация будет идти от 0% до 

100%, а затем немедленно обратно к 0% и так бесконечно. 

Название анимации используется, по крайней мере, дважды: 

● при написании анимации с помощью @keframes; 



 

 

● при использовании анимации с помощью свойства animation-name (или 

через сокращённое свойство animation). 

@keyframes whatever { 

  /* ... */ 

} 

.selector { animation-name: whatever; } 

Подобно именам классов CSS, название анимации может включать в себя 

только: 

● буквы (a-z); 

● цифры (0-9); 

● подчёркивание (_); 

● дефис (-). 

Название не может начинаться с цифры или с двух дефисов. Как и 

длительность перехода, длительность анимации может быть установлена в 

секундах (1s) или миллисекундах (200ms). 

 

.selector { animation-duration: 0.5s; } 

 

Значение по умолчанию равно 0s, что означает отсутствие анимации 

вообще. Подобно функциям времени для переходов, функции времени для 

анимации могут использовать ключевые слова, такие как linear, ease-out или 

могут быть определены с помощью произвольных кривых Безье. 

Как и с задержкой перехода, задержка анимации может быть установлена 

в секундах (1s) или миллисекундах(200ms). По умолчанию равно 0s, что 

означает отсутствие любой задержки. Полезно использовать, когда включается 

несколько анимаций в серии. 

 

Лабораторная работа №8: Создание макетов веб-приложения 

Создадим файл с гипертекстовым документом и выполним нижеописанные 

шаги. 



 

 

 Запустим текстовый редактор, введем текст: 

Приветствую Вас на моей первой web-страничке! 

 Сохраним файл в созданной папке. При сохранении, в окне диалога 

Сохранить как… в строке Тип файла: выбрать вариант Все файлы (*.*) 

, а в строке Имя файла задать имя с расширением .htm, например 

1_name.htm (где name – ваше имя) 

Создадим разметку, определяющие структуру html-документа. 

Ввести приведенные ниже теги, в разделе заголовка документа (между 

тегами  <TITLE> </TITLE>) указать свою фамилию. 

<HTML> 

<HEAD> <TITLE> Фамилия </TITLE> 

</HEAD> 

<BODY> 

Приветствую Вас на моей первой web-страничке! 

</BODY> 

</HTML> 

Отредактируем документ и добавим после текста   «Приветствую Вас на 

моей первой web-страничке!»  текст подписи: 

Студент группы NNN  Фамилия  Имя 

Используя одиночный тег <BR>, отредактируем документ так, чтобы 

подпись начиналась с новой строки, а Фамилия Имя – в следующей строке. 

Просмотреть в броузере новый вариант.  

Оформим фрагменты текста с помощью стилей Заголовков: 

 Первую строку документа оформим стилем Заголовок 1-го уровня с 

помощью парного тега <H1> …</H1>. Вторую строку оформим как 

Заголовок 6-го уровня, а третью как Заголовок 4-го уровня. 



 

 

 Поменяем стиль оформления первой строки на Заголовок 2 уровня, 

второй строки - на Заголовок 5 уровня, последней строки  - на 

Заголовок 3-го уровня.  

Выполним форматирование шрифта: 

 После строки  Фамилия Имя добавим  еще одну строку текста: 

Нас утро встречает прохладой 

 Оформим фразу по приведенному ниже образцу. 

 

В слове «УТРО@ все буквы должны иметь разные цвета. В слове 

«ПРОХЛАДОЙ» оформить буквы «ПРО» – красным цветом, «ОЙ» – синим.  

 Оформим строку с подписью  (Студент группы NNN  Фамилия  Имя) 

курсивом, размер шрифта задать относительным изменением. 

Использовать теги <FONT SIZE=«+2»> и <I> 

 

Выполним форматирование  абзацев: 

 Создадим новый документ 2_name.htm, сохранить его в той же рабочей 

папке. 

 Введем текст (использовать копирование текста из документа 

1_name.htm):  

<HTML> 

<HEAD> <TITLE> Фамилия </TITLE> 

</HEAD> 

<BODY> 

Приветствую Вас на моей второй web-страничке! <BR> Монолог Гамлета 

</BODY> 



 

 

</HTML> 

 Выровняем текст по центру. 

 Введем текст: 

Быть иль не быть - вот в чем вопрос. Что благороднее: сносить удары 

неистовой судьбы - иль против моря невзгод вооружиться, в бой вступить. И 

все покончить разом... 

 Оформим выравнивание абзаца по ширине. 

 Ограничим абзац горизонтальными разделительными линиями сверху и 

снизу, используя тег <HR>.  

 Скопируем монолог и разобъем его на абзацы.  

Быть иль не быть - вот в чем вопрос. 

Что благороднее: сносить удары 

Неистовой судьбы - иль против моря 

Невзгод вооружиться, в бой вступить 

И все покончить разом... 

 Создадим «смешанный» список: 

Я знаю как оформлять: 

1. Шрифты 

 Размер 

 Цвет 

 Гарнитуру 

 Индексы 

2. Заголовки 

 От 1-го до 6-го уровня 

3. Абзацы 



 

 

 Выравнивание 

 Разрыв строк внутри абзаца 

 С использованием переформатирования. 

 

 


